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Overview

SSi's HB1000 Series In-Furnace Data Logging Device provides data gathering capabilities in a
unit designed to withstand the stress of monitoring temperature from within a furnace. The
thermal barrier is constructed with a stainless steel exterior and insulating components that
protect the internal electronics for extended periods of time at temperature. The high accuracy
electronics component supports 10 type K thermocouples with a maximum battery life of 40
hours. Using the USB connection, data can be easily imported into SSi's SDS Reporter software
for AMS 2750 E compliant reports.

IMPORTANT!

The Thermal Barrier and Heat Sink must not be used in atmosphere, under vacuum, or for high
pressure quench, unless the product is ordered for that specific application. If the product has
not been ordered for the specific application, damage will occur, and the product warranty will
be voided. See the Warranty section on page 57 for more specific details on warranty.

Electronics Component

uperSystems

www.supersystems.com

HBDL

10 Channel Data Logger

BLINKING: Power On / SOLID: Charging
BLINKING: USB Connection Active
BLINKING: Data Logging In Progress

MADE IN U.S.A

BLINKING: Data Transmission via USB /N 1360

The switch on the bottom of the box turns the power on and off. Next to the switch is the USB
port. When the electronics are not in use, the unit should be powered off and connected to a

computer to charge. Keeping the unit powered off while not in use will drastically improve its
battery life.
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The functions of the LEDs are as follows, starting with the LED furthest from the switch:

1. Yellow LED. Blinking when power is on. Stops blinking but remains lit when connected to a
computer via USB, thus charging.

2. Red LED. Blinking when connected to a computer via USB.

3. Red LED. Blinking when datalogging.

4. Green LED. Blinking when data is being transmitted via USB.
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Data Logger Electronics Specifications

Accuracy: +0.9°F [£0.5°C]
Resolution: 0.2°F [0.1°C)

Maximum Operating Temp: 158°F [70°C]

Mumber of Channels: 10

Trigger Channel: CH1

Sample Interval: 1 Second

Recording Start/Stop Ternp: Set Via USBE port
Memory Type: Mon-Volatile Data Flash

784,432 Imemory fully loaded)

Data Points: 194,408 [one memory chip loaded)

Battery Type: Lithium Palymer

Max Battery Life: 40 Hours Between Charges

Battery Charging: Via USE Port [or external supplyl

Communications: Via USB Port

Data Logger Reset: Via USB Port

Super Systems Inc. Page 7 of 58
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Thermal Barrier

Figure: HB 1015 unit. HB 1012 unit not pictured.

Elements of the Thermal Barrier

High temperature Fabric

Heat Sink

Sensor Outlet

Toggle lock engagement Handle Wear 5trip (| Toggle lock Guide

Data logger Pocket
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There are several guidelines to follow that will ensure the longest life of the thermal barrier:

1.

2.

10.

1.

Do not let the high temperature fabric in the lid and the base rub or abrade against any
surface. Keep the cloth facing upwards when the unit is open.

Store the thermal barrier in the pelican case it is shipped in. If it cannot be stored in the
pelican case, it should be kept in a dry location. In this case, it is recommended that the
thermal barrier be kept inside a plastic bag.

Replace the wear strips with new ones before the high temperature fabric is damaged. The
high temperature fabric should not come in contact with the sensor cables.

The start temperature of the thermal barrier should be less than 77° F (25° C).

If possible, keep the barrier unbuckled during storage.

When the thermal barrier has just come out of the furnace and is hot, open the lid and keep
the unit on a perforated surface to let it cool down. Handle with high temperature gloves.
Any time the unit is unbuckled, it should be prevented from sliding to reduce wear on the
matting.

When placing the upper half on top of the lower half, keep the wear strips clear of the
sensor outlet guide.

When locking the thermal barrier, place all four toggle clamp arms into the engagements
before pressing the toggle clamps down to lock. Similarly, when unlocking, loosen all four
clamp arms before pulling apart from the engagements.

NEVER EXCEED THE THERMAL CAPACITY ( TEMP / TIME CAPACITY ). Refer to chart below.
Neither unit should be used at temperature above 1832° F (1000° C) for any amount of time.
After use, the Thermal Barrier must be cooled fully before being used again.
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Thermal Barrier Specifications

Temperature in Temperature in HB 1012 Max HB 1015 Max
°F °C Time at Temp Time at Temp
482 250 7hrs 30min 13 hrs
572 300 5hrs 45min 10hrs 30min
662 350 4hrs 45min 8hrs 35 min
752 400 4 hrs 7hrs 25min
842 450 3hrs 30min 6hrs 30min
932 500 3hrs 30min 5hrs 35min
1022 550 2hrs 50min Shrs
1112 600 2hrs 30min 4hrs 40min
1202 650 2hrs 15min 4hrs 15min
1292 700 2hrs 10min 4hrs
1382 750 2hrs 3hrs 45min
1472 800 1hr 50min 3hrs 30min
1562 850 1hr 45min 3hrs 15min
1652 900 1hr 45min 3hrs
1742 950 1hr 30 min 3hrs
1832 1000 1hr 30 min 2hrs 50min
DO NOT OPERATE AT TEMPERATURES ABOVE 1832° F (1000° C)

IMPORTANT!

If you have a Thermal Barrier that is not on the list, make sure the proper time and temperature
guidelines are followed!

Guidelines for Thermocouple Wire Sheath

The recommended wire sheath diameter for mineral-insulated thermocouples is 1.6mm. It is
also recommended that the wire be Inconel- or Nicrobel-sheathed and terminated with a high
temperature miniature plug.

Using the Thermal Barrier with the Data Logging Electronics
1.
2.
3.

b.

Open the thermal barrier and set the halves next to each other.
Insert the data logger into a plastic/polythene bag.
Set the heat sink up so that the pocket faces upwards, and insert the data logger into the

pocket.

Lean the heat sink onto the edge of the thermal barrier as shown in picture 2 and route

the thermocouple wires through the sensor outlet guides.

Super Systems Inc.
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5. Place the upper half on top of the lower half, keeping the wear strips clear of the sensor
outlet guides. Fasten all four toggle locks.
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Replacing Wear Strips

To replace the wear strips, simply unscrew the locking plate and put the new wear strip in
place. Screw the locking plate back on.
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Getting Started

To begin using the HB1000, first load the SDS Reporter software provided with the unit onto a
computer.

Connect thermocouples to the data logger. Channel one must be connected in order to collect
data. The thermocouples can be connected using a mini adaptor. When connecting the
thermocouples, the positive side is down and is the smaller of the two terminals.

Next, connect the data logging electronics to the computer with a USB cable. Verify that the
USB Connection Active LED is blinking red. Instructions for installing the driver for the HB1000
can be found under Install Driver on page 16. Assign the on and off data logging temperatures
for the unit. For continuous data logging, the on temperature should be set to 0°F or C and the
off temp to 1°F or C. Instructions for setting the on and off temperatures can be found under
Device Settings on page 17. Thermocouple one controls the on and off status of the data
logging; this cannot be assigned to any other thermocouple. Once the on and off temperatures
are assigned, disconnect the unit from the computer. If the on temperature is below ambient
temperature, the Data Logging In Process LED should be blinking red.

At this point, the data logger setup is complete. The data logger can be placed into the heat
sink with the thermocouple wires facing out. Please see the section Using the Thermal Barrier
with the Data Logging Electronics to ensure proper arrangement of the parts.

Once the HB1000 has come out of the furnace, pull the electronics component out of the
thermal barrier as quickly as possible. The thermal barrier should be handled with heat
resistant gloves. After removing the electronics, turn the switch OFF and connect the unit to a
computer with a USB to charge. This will discontinue data logging. Keeping the unit turned off
or charging when it is not in use will greatly prolong the battery life of the electronics.

Before beginning a new survey, the electronics must always first be connected to the computer
and scanned by the Uniformity Box software if the device has been turned off. Once the device
has been found, it will have the same On and Off temperatures assigned from the previous
survey, and it can be disconnected from the computer at that time to begin data logging.

Downloading a Survey

Connect the electronics to the computer with a USB cord. Verify that the USB Connection Active
LED is blinking red. To download a survey, go to SDS - Download Surveys and Data, and select
the unit from the SDS drop down menu. Hit the Download button. The program will download
every job (survey) on the unit each time this operation is performed. To delete old jobs from the
device, use the Erase Jobs button on the Device Settings menu. Erasing jobs is discussed
further in the Device Settings section.

Once the jobs are downloaded, close the window. Select File > New. The Report Properties
tab will open. The first box on this page is labeled Data Sources. Click the button with three

dots —I next to the Data field. This will display the Load Survey Data window. Select the
appropriate job; the most recent job performed will be at the top of the list. Once the job is
highlighted, a template can be used by clicking the Attach Template to Survey button in blue
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located just below the list of jobs. This will display the Open Template File window with the
option to open a local survey template file located on the computer. Hit the Browse button,
select the appropriate template, and press Open. Hit the Open File button at the bottom of the
Open Template File window. This will display the Select Template window. Highlight the
appropriate template, and hit Ok. Now, press the Use button in the Load Survey Data window.
For more information on creating a template, please see the section SDS Template Manager.

At this point, the data from the job performed as well as the data fields that correspond to the
selected template will be populated. Any other necessary information can be entered by
clicking through the Report Properties tabs. For more information on this, please see the
section SDS Reporter Software. The chart for the survey can be viewed by clicking the Chart
tab.

To create a report using this job, click the —| button next to the Report Template field,
located on the Report tab of Report Properties. Select the appropriate report file, and hit Open.
Go to File & Print Preview = Print Preview Report to view the report. The report can be printed
from here. For more information on creating a Report Template, please see the section
Creating a Personalized Template.
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HB1000 Software

The HB1000 software provides a simple interface for accessing data collected by the uniformity

File 5DS Options Help
J = d &

box.

Open SDS Reporter and
choose SDS - Uniformity Box
settings.

& Super Systems inc. 505 Reporter

File [SDS| Options Help

B

SDSReporter - Ready

Manage Survey Templates
Download Surveys and Data
Launch Direct FTP

View Real-time Data
Manage Survey Records
Uniformity Box Settings

Perform Comms Test

HB1000 Menu

The HB1000 Menu consists of three
buttons: Calibrations, Device
Settings, and Install Driver.

At any point, clicking the red X in the

top right corner will bring the
operator back to this menu screen.

Super Systems Inc.

o5l Uniformity Box

Calibrations

Device Settings

Install Driver
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Install Driver

First, connect the unit to the computer via a USB cord. Select Install Driver. This will bring up
the following screen:

a5l Install Driver = | B ||

Start Driver Installation

Messages

Click the Start Driver Installation button. This will allow the software to recognize the device.

o) Install Driver = | B |

There will be messages stating the driver

Start Driver Installation installation has started and has been
successful. Click the red X to return to
the Menu.

Messages
10:50:25 AM: Driver Installation Started
10:50:27 AM: Complete: Driver installation successful.
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Device Settings

o === Pressing the Scan for Devices button will
Scan for Devices display a list of the devices on the network in

o the top left corner. If the device has been
Device Time Set Time given a serial number, this is how it will be
On Temp SetOnTrigger |° || displayed, along with the port it s
Off Temp et Of Trggor - commumcatmg tp. Se_lect the appr_opmate
device. The settings displayed will include

Serial Number text cannot be left blank. i
Set Serial Number

the Device Time, the On Temp, the Off Temp,
Degree Type F -l and the Serial Number. On the right hand
side of the Device Settings window, there are
four buttons which allow the operator to
change the settings. Channel one will
always control the on and off temperature.
The device must be selected before changes
can be made.

Erase All Jobs

Messages

The Set Time button will change the time on the device to match the time on the computer it is
connected to.

The Set On Trigger button will change the On Temp for the HB1000. When thermocouple one,
which controls data logging, reaches this temperature, the controller will begin data logging.
The Set Off Trigger button will change the Off Temp for the controller. When thermocouple one
reaches the off temp, a timer will count down from 10 minutes. After this timer is finished, once
the temperature falls below the off temp, the data logger will stop recording data. For
continuous data recording, it is recommended that the on temp be set to 0° and the off temp be
set to 1°.

The Set Serial Number button allows the operator to name the device. This can be a name
using letters, numbers, or a combination of the two.

The Erase All Jobs button will erase all of the data from the device. This will erase all jobs from
the device; it is not possible to choose only certain jobs to erase and to keep others. Erasing the
jobs will take 60 seconds, and a timer will count down during this operation.

The Degree Type allows you to set the unit of temperature measurement - °F or °C - used for
calibration.

Super Systems Inc. Page 17 of 58
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(T Uniformity Box Calibration [E=m=
Devices
[COM4]
Scan For Devices
Cold Junction Calibration Zero Calibration
Span Calibration TC Trim Calibration
Messages

There are four types of calibrations for the HB1000. All of the thermocouple channels must be
calibrated at the same time.

Zero Calibration

To calibrate the voltage properly, both a zero and a span calibration must be performed. For

o e ]
Input Value
Input 1 194.26
Input 2 194.26
Input 3 194.46
Input 4 194.47
Input 5 193.87
Input 6 193.88
Input 7 194.15
Input 8 194.16
Input 9 194.16
Input 10 19417 Start Calibration
Messages

Super Systems Inc.

zero and span calibrations, only
regular copper wire should be
used - not T/C wire. Connect
each positive input to its
corresponding negative input or
connecting a calibrator and
outputting 0.0 volts DC (VDC).
Once the connections are made,
press the Start Calibration
button. Theoretically, this
should yield 0.0 VDC, however
many times it is close but not
quite 0. Now a span calibration
should be performed.
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Span Calibration

Following a zero calibration, perform a span calibration.

regular copper wire should be
used - not T/C wire. To
perform a span calibration,
hook up a calibrator to each
input. From the calibrator,
output 72 millivolts. Set the
Calibration Value to 72 mV on
the computer software. The
voltage range should be set to
80 mV for a type K
thermocouple. Press the Start
Calibration button. More often
than not, the scaled voltage
will read something slightly
off from 72 mV, for instance
72.09 instead of 72. The
voltage is then calibrated
according to the results of the
zero and span calibrations.

T/C Trim Calibration

[ ol Span Calibration

For zero and span calibrations, only

o] . [ |

Input Value Calibration Value: 0.00
Input 1 194.26

Input 2 194.26

Input 3 194.46 Voltage Range: 2560mV. =
Input 4 194.47

Input 5 193.87

Input 6 193.88

Input 7 194.15

Input 8 194.16

Input 9 194.16

Input 10 194.17 Start Calibration
Messages

For the T/C Trim calibration, T/C wire should be used. The T/C trim calibration is performed by

Input Value Calibration Value: 0.0
Input 1 330.8

Input 2 330.8

Input 3 330.8

Input 4 330.8

Input 5 330.8

Input 6 330.8

Input 7 330.8

Input 8 330.8

Input 9 330.8

Input 10 330.8 Start Calibration
Messages

the ambient temperature could possibly be.

Super Systems Inc.

connecting a thermocouple
calibration device to each
input and outputting a trim
temperature that is used be
equal to the  expected
operating temperature. For
example, the calibration could
be completed using an output
temperature of 1700°F. After
the Zero, and span
calibrations, the temperature
may read about 1701.5°F
instead. This  type of
calibration should be used in
lieu of the regular cold
junction calibration unless the
cold junction temperatures
are reading a temperature
that is much too high for what

A cold junction calibration can be used in this
instance when need be, but the T/C Trim Calibration is preferred.
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Cold Junction Calibration

The purpose of the Cold Junction Calibration is to calibrate the ambient temperature at each of

Input Value Calibration Value: |0.00
Input 1 82.33

Input 2 82.23

Input 3 82.25

Input 4 82.16

Input 5 82.12

Input 6 82.13

Input 7 82.07

Input 8 82.27

Input 8 82.3

Input 10 82.28 Start Calibration
Messages

Super Systems Inc.

the 10 connectors. The ambient
temperature can be determined
by holding a probe near the
connectors and reading that
value. The operator should then
enter the ambient temperature
into the box labeled Calibration
Value. Press the Start
Calibration button to run a Cold
Junction calibration. Each input
will then be reading the ambient
temperature. A message will be
displayed stating that the
calibration is successful.
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SDS Reporter Software

Menu
When the SDS Reporter software is started, the Menu screen i

s displayed.

The four menu options to
choose from are: File, SDS,
Options and Help. There are
four buttons to choose from:

New D Open ﬁ, Save
E, and Print & The

Open menu option will allow
the wuser to choose an
existing report from a
common  Windows Open
dialog box. The software will
open the dialog box in the
“SDSReports” folder
(typically -C:\SSI\SDS\SDSReports) for existing reports ((SDSReport] to open.

The New option allows the user to create a new report that will include the report properties,
the trend chart, and the T/C data. Of these three tabs, the selected tab will be in Red when it is
active.

& Super Systems inc. SDS Reporter

DlelE]e]
prer—
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Report Properties Tab
The Report Properties tab contains several tabs, which in turn contain the information that
makes up the report.

Report
The first tab is the Report tab which contains the data to use for the report, the report template
to use, the report heading or title, the survey results, and any notes about the report.

t’l Furnace I Survey Box I Thermocouples I Survey Details I Survey Parameters I Controller I User Defined I

—Data Sources

Data | | I
Report Template: | | 000 I

SDS Report
Report Heading J Title [ I

Survey Results (PassjiFail) [ ]

Motes

Clicking on the open box, —| , next to the Data field will display a screen from which the user
can select the interval time (ten seconds, twenty seconds, thirty seconds, one minute, two
minutes, or five minutes) and also the specific survey to use.

@ Load Survey Data - B
Degree Type: T :Iv mﬂ: |-I Minute D
11/14/2012 11:11 AM - 1:11 PM [Manual Entey] (SDSOOT) Y

11142012 9:24 AM - 11:24 AM  [Manual Ertry] (SDS001)
111372012 10:41 AM - 2:41 PM  [Manual Ertry] (SDSCT203002)
10/19/2012 2:14 PM - 2:53 PM #16: [Alcoa Sylmar - #16] (SD5001)
10192012 2:12 PM - 214 PM #16: [Aleoa Sylmar - #16] (SDS001)
10792012 10:42 AM - 216 PM #16: [Alcoa Sylmar - #16] (SD5001)
10792012 10:33 AM - 10:33 AM #16: [Alcoa Sylmar - #16] (SDS001)
10/9/2012 10:20 AM - 10:32 AM #11: [Alcoa Sylmar - #11] (SDS001)

5/28/2012 3:55 PM - 428 PM  E-10: [Phoenix Heat Treating Inc. - E-10] (SDSC1205002) b
Attach Template to Survey Advanced: Manually Create 3 Survey Pecord
Cancel ET
Y

This screen will only display survey data that has already been downloaded. To download
surveys, choose SDS — Download Surveys and Data. This is explained further under the S0S
Menu Options section.

Super Systems Inc. Page 22 of 58



HB1000 Series Thermal Barrier Operations Manual

The default interval is one minute. Select the survey to use and click the Use button.
Information included with the data sources is: Template Name, [Company Name - Furnace Id],
(Survey box Serial number], and the date/time range of the survey data. Clicking on the open
box next to the Report Template field will open a dialog box from which the user can select the
specific report template to use for the report. The software will open the dialog box in the
SDSReportTemplates folder (typically C:\SSi\SDS\ReportTemplates]) for existing report
templates to use. The Report Heading / Title field is for the heading or title of the report and the
Survey Results (Pass/Fail) field is for the results of the survey. The Notes field is for any
general notes for the report.

Note that the Load Survey Data window provides the ability to attach a template to a survey. To
do this, click on Attach Template to Survey and select the template you want to use before
clicking on Use.

Survey Parameters

The Survey Parameters tab contains: the survey tolerance, the survey setpoint, the overtemp
setpoint, the simulated load in pounds, the microns, and the option of heating or cooling.

]MI Survey Parameters |Sur~.re3,r Details | Thermocouples | Survey Box | Furnacel Controller I User Defined | ComparisonCheck|

Survey Parameters

Survey Tolerance [+/

Survey Setpoint

Simulated Load (lbs)

| |
| |
Cvertemp Setpoint | |
| |
Microns | |

Heating/Cooling: [Heating - ]

5DSReporter - Ready
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Survey Details

The Survey Details tab contains the company name, the survey start date, the survey duration,
the actual duration of the survey, the survey specification(s), who performed the survey, who
approved the survey, the date range for the survey, and the due date of the next survey.

FRepork ] Furnace ] Survey Box ] Thermocouples= __ ] Survey Paramekers ] “ontroller ] User Defined ]

Surwey Dekails

Company Mame |Super Swskems inc |

Surwvey Stark Dake | |

Surwvey Durakion |DD:3EI:DEI Sckual: I:l
Surwvey Specifications |.C\.MS Z27F5S0-C
Performed Byw |Tim el

Dakte Range For Surves: |

|
|
approved By | |
|
|

Mex<k Surveyw Due |

Thermocouples

This tab contains the information about the thermocouple settings and it also lists the active
thermocouples. The information in the thermocouple settings includes: the temperature type
(F or CJ), the number of thermocouples, the number of T/Cs used in the report, the
thermocouple type, the thermocouple gauge, the thermocouple spool number, the person who
performed the calibration, the date the thermocouple was calibrated, and the thermocouple
spool correction factor.

Repork ] Furnace ] Surwvey Box

Surwveyw Details ] Surveyw Parameters ] Zontroller ] User Defined ]

Thermocouple Settings

Temperakture Type (F or <)
mMumber of Thermocouples # TCs Used in Repork I:I

Thermocouple Spoal Mumber |Z458

Thermocouple Calibrated by

Calibrakion Dake |
Thermocouple Spoal Carreckion Fackor “hange

active Thermocouples

I~ 1 e I~ 11 I~ 16 =1 I 2a =1 T
I+ = — = 1z I == 27 I = | 37
I = — = I 13 15 | 23 — 25 — 33 =5
4 I~ = 14 I 19 24 =29 34 39
= I~ 10 W 15 [ =0 — 25 I =0 — 35 [ 40
Define Conkrol TC Misws OFfseks used in Surve

New Spool Correction Factor Dialog = Cl|Ck|ng on the Change button will
Flease enter the new oifset allow the user to change the spool

correction.
Cancel

All values displayed to the users are
corrected. That means if there is a
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defined offset for the T/C Spool and a channel offset, the user will be shown the net result of
those offsets into the value displayed.

There are checkboxes for a possible forty thermocouples, but only the active thermocouples will
have checks in the checkboxes. Clicking on the Define Control T/C link will allow the user to
select the T/C or T/Cs that will be the control T/C(s). The operator can select any of the
thermocouples to be the control T/C(s) and provide an optional description for that T/C.

Clicking on the Accept button will
o e e g e A TE Yow mag o set the selected control T/Cls).
—, Descreten —,,  escrten Once a control T/C(s) has been
— = — 22 selected, the T/C's number will
= — 23 : “ .
—— i be in Red E)n the Active
5 25 Thermocouples” section of the
F ? F 3? Thermocouples  tab. The
— & — g thermocouplels] that is identified
39 I~ 29 ;
— o — o as the control T/C will not be
[ — =1 used for the T/C summary when
F 12 F 2 identifying hottest and coldest
— 14 — 24 channels.
=l s . =5 Clicking on the View Offsets used
18 36 in Survey link will display a list of
17 — 27
— 15 — a5 the offsets that were used on the
— —
— — survey. All values that are
Accept | Cancel | displayed to the users are
corrected values. That means

the Offsets defined for these T/Cs have already been incorporated into the value the operator
would see. If there is a value for the T/C Spool Correction Factor, that value will also be

incorporated, providing a corrected view for the user.

ISy
TC I I

TC
TCZ2
TCZ
TCS
TC10O
TC11
TC12
TC1S
TC1E
TC19

]
7
o

Note: Checking or unchecking T/Cs on the Thermocouples Tab
will affect the T/Cs plotted on the Chart Tab.

ooooooooo0

Close I
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Survey Box

The next tab is the Survey Box tab, which contains information about the survey box itself, such
as the make and model, the serial number, the person who calibrated the survey box, and the
calibration date.

Fepork ] Furnace '

~| Thermocouples ] Surveyw Details ] Surveyw Parameters ] Conktroller ] User Defined ]

Surwveyw Box

Survew Box Make/Model | |

Surwveyw Box Serial Mumber I:I

Survey Box Calibrated Bw | |

Surwvey Box Calibration Dake | |

Furnace

The Furnace tab contains the furnace ID, the make and model of the furnace, the furnace type,
the furnace use, the furnace’s operating range, the furnace dimensions, the furnace class, and
an optional image of the furnace.

Furnace Details

Furnace ID |# 103 |

Furnace Make | Maodel |I|:|sen 1842 |

Furnace Tvpe |'-.-'acuum - Zbar Quench |

Furnace Lse |Heat Treating |

Furnace Operating Range |1|:|EIEI-24EIII| |

Furnace Dimensions |6Ij" w 60" |

Furnace Class I:l

Load Map Image

]

Clicking on the open box next the image frame will open a dialog box where the user can search
for an image of the furnace to display.
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Controller

This tab contains the Controller manufacturer, the controller model, and the instrument type in
the Temperature Controller Settings. This tab also contains the PID Settings: cycle time, dead

band, output limit, PB (Gain), rate, and reset.

Repark ] Surwey Parameters ] Survey Details ] Thermocouples ] Surwvey Box ] Furnace ,

Temperature Controller Settings

Zontroller MFg.
Controller Model

Instrument Type

FPID Setting=
Zwele Time

Dead Band
Cwgkpuk Limik
PE {Gain)
Rakte

Reset

User Defined

|H0neywell

||_|Dc 3500

\] User Defined ]

This tab contains twenty fields that can be defined by the user and included in the report.

Report ] Survey Parameters ] Survey Details ] Thermocouples ] Surwey Box ] Furnace ] Cankraller

User Defined Tag 1 |
Lser Defined Tag 2 |
Lser Defined Tag 3 |
LUser Defined Tag 4 |
LUzer Defined Tag S |
Uszer Defined Tag & |
Uszer Defined Tag 7 |
User Defined Tag 8 |
User Defined Tag 2 |
User Defined Tag 10 |

Lser Defined 11|

Super Systems Inc.
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To create a user defined field, click on the Modify User Defined Fields. This will display a screen
that will allow the user to edit the fields. The user can type in the name or description of the
field and click the Save button. These inputs can then be implemented in the report using the

SDS Data Tags.

Edit User Defined Fields

Lser Defined 1:

Lser Defined =:

Lser Defined 3:

Lser Defined 4:

Lser Defined S:

Lser Defined &:

Lger Defined 7:

Lser Defined S:

Lser Defined 9:

LUser Defined 10:

Canhc

ILlser D efined 2

IUser Defined 32

IUser Defined 4

IUser Defined 5

IUser Defined &

IUser Defined 7

IUser Defined &

ILlser Defined 9

|Uzer Defined 10

el I

Save I

Comparison Check

File SDS Options

NEIEIRS

Report Properties I Chart] Datal

Help

Report] Survey Parameters] Survey Details Thermocoup\es] Survey on} Furnace} Controller | User Defined ComparisonCheck I
Preview Report ‘ Print Report | Control Low High
Comparision TCs |1 ‘2 |3
FumaceID |ID123 Adjacent TCs |4 ‘5 |5
Set Peint 350 Comparison Test T/C Wire Correction Factor |0 ‘U |0
Furnace Class  |A I Use Custom Wire Correcticns
Ambient Temp |0
Comparison Test T/C Spool Number 2458 Accept/Reject Criteria [0
Header Text Body Text
P T o Comparison Comparison  Comparison | Comparison Adjacent Ad - Adjacent Adjacent A(:.ept,f =
Srucess WIC'IE' s Test TC | Comparison | TC Wire Instrument TC TC Téi;'en Instrument TC REJE_C': Accept /
TEntSUdr Int ml Spool Correction = Correction | Temperature,  Number c dI:rE Correction Tarnpe.rature Difference Criteria = Reject
sste s Number Number Factor Factor Readings for errechion Factor Reafdlngs 'I;Dl\:eraﬂce
Control 7:01:58 PM | 2458 1 1] 0 362.5 . 0 0 356.8 57 +/-0 R
> |Low 70158 PM | 7458 2 0 0 T 0 0 3525 31 /-0 R
High 7:01:58 PM | 7458 3 a 0 368.6 6 1] 0 841 2845 +/-0 R
Control T:11:58 PM | 2458 1 1] 0 359 4 0 0 347.2 118 +/-0 R
Low 7:11:58 PM | 2458 2 1] 0 3489 5 0 0 350.3 -14 +/-0 R
High T:1L:58 PM | 2458 3 a 0 3594 6 [ 0 819 27115 +/-0 R
* |

Super Systems Inc.
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The information for the comparison check is generated from several of the Report Properties
fields.

Report Field Location in Tabs
Time Chart Start Time
Comparison Test T/C | Middle Left of Comparison
Spool Number Check
Comparison T/C Top Right of Comparison
Number Check
Comparison T/C Wire Top Right of Comparison
Correction Factor Check
Comparison
Instrument Correction Thermocouples
Factor
Comparison T/C Records the temperature
Temperature Readings of the Comparison T/C
Adjacent T/C Number Top Right of Comparison
for Comparison Check Check

. , Thermocouples, click View
Adjacent T/C Wire Offsets Used in Survey
button*
Thermocouples, click View
Offsets Used in Survey
button

Correction

Adjacent Instrument
Correction Factor

Adjacent T/C
Temperature Readings
for Comparison Check

Records the temperature
of Adjacent T/C

Difference Between
CC Difference Comparison T/C and
Adjacent T/C temperatures

Accept/Reject Criteria = | Set on Comparison Check
Tolerance of Furnace Page, Middle Right

Accept/Reject Dependent on A/R Criteria

*The offsets for the T/C Wire Correction can be adjusted solely for the purpose of the

comparison by checking the box on the Comparison Check page labeled Use Custom Wire
Corrections.

A header text and a body text can be put in the report. There are Preview Report and Print
Report buttons in the top left hand corner of the Comparison Check page.
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Chart Tab

The Chart Tab contains the charted information from the time specified on the survey. When
the chart tab is active, the chart toolbar buttons also appear and these buttons can be used to
zoom in on a section of the chart, pan the chart up, down, left or right, and refresh the chart
back to its original values. The screen will display 2 horizontal lines that represent the high and
low temperature tolerance levels based on the setpoint. This display will change based on the
tolerance level and setpoint defined in the Report Parameters.

€ Super Systems inc. SDS Reporter B P ] 24
Eil= SDS Options  Help

O |zl e =

Report Propertiss ] Chartl Data ]

03/26/2006 12:09:13 AM
Plot Value =S| | =
TC 1 361.7 E
E
TC3 362.9 00 o
TCca |3528 E
TC S 352.4 Fo0 =
TCE 86.8 El
TC7 | 25019 E
TCs 2501.9 500 3
TC9 2501.9 El
TC10 | 2501.9 500 =
COrc a1 | s E
CITcaz | === E
COTc13 | = 4005
CITcaa | = E =
Ovcas | === 300 2
CITC 16 | =*aer E!
Cdvcags | = 2002
] E
O 3
Cltc 20 | = 100 = |~
] =
0 0=
Cdice2s | = E
] b E
[ 100 =
] 3
] 200 £
| E
Cltc2g | === E
CITC 30 | == e T T T T T T e e T T S T T
Orcs1 | e =1 T:00 PM F15 PM
— Time
|Survey Start: 4.36:13 PM |Survey End: 7 4413 Ak |Duration: 2.15.08: .00

Note: checkmg or uncheckmg T/Cs on the Chart Tab will affect the Active T/Cs on the Report
Properties - Thermocouples tab.

Data Tab
The Data Tab contains the data from each thermocouple for the each interval selected from the
Load Survey Data screen.

Eile  SDS oOptions  Help

D lesll=]lss]

Report Propertios | chart | Data |

Tirne = = = = Tos Toe = Tos =) Toio
> 5133118 PM 7.6 Fo.2 9.4 1 Fo.1 3.5 =2s01.9 =2s01.9 zso1.2 zs01.9
s:33:zEPM 76 0.5 5.8 0.6 53.3 737 zs01.9 zs01.3 zs01.3 zs01.9
53338 PM 7S.8 5.5 Fo.2 717 0.7 3.2 =s01.9 =s01.2 zs01.2 zs01.9
513348 PM 743 748 9.1 o9 3.5 3.1 =2s01.9 =2s01.2 zso1.2 zs01.9
53358 PM 73.9 5.2 o 1.6 o 3.7 =s01.9 =2s01.2 2s01.2 zs01.9
siz4:08PM 728 747 1.6 1 593 3.2 2s01.9 =2s01.2 zso1.2 zs01.9
£i34:18PM 724 74.7 0.3 1 s9.5 3.9 z501.9 2501.9 2501.9 z501.9
siz4:zaPM 725 5.5 Fo.3 1.8 Fo.5 F4.1 =s01.9 =2s01.2 2s01.2 zs01.9
siz4:3sPM 722 5.7 Fs.8 Fz.2 Fo.9 3.5 =2s01.9 =2s01.2 zs01.2 zs01.9
sS4 45 PM 715 73.5 ve.4 1.5 o4 7S zs01.9 zs01.9 zs01.9 zs01.9
SiZ4:S5PM F1.7 73.5 5.2 7z.3 1.8 5.9 =s01.9 =s01.2 zs01.2 zs01.9
siSs:08FPM FO.2 2.3 Fa.1 o9 1 759 =2s01.9 =2s01.2 zso1.2 zs01.9
siZS:18PM F1.3 2.5 4.3 ¥3.5 7.5 749 =s01.9 =2s01.2 2s01.2 zs01.9
siZsizEPM Fl.e 2.5 o 3.3 a3.2 s 2s01.9 =2s01.2 zso1.2 zs01.9
635138 PM 718 2.3 ¥3.8 F3.1 826 5.1 25019 2501.9 25019 z501.9
siZs:4sPM 71 1.4 vz.7 7z sz.1 7.5 =s01.9 =s01.2 zs01.2 zs01.9
53555 PM FO.6 1 Fz.3 1.6 3.5 T4z =2s01.9 =2s01.2 zso1.2 zs01.9
6iZ6:08PM F1.6 7z 73.3 7z.6 83,7 741 zs01.9 zs01.9 zs01.9 zs01.9
siZ6:1sPM  Fl.e 717 73 7z.3 sz.2 7.5 =s01.9 =s01.2 zs01.2 zs01.9
siZeizEPM  F1.5 1.9 Fz.8 7z.8 s0.7 4.3 =2s01.9 =2s01.2 zso1.2 zs01.9
613635 PM 71,7 1.9 Fz.2 ¥3.8 o5 3.5 =s01.9 =2s01.2 2s01.2 zs01.9
siZ64sPM  F1.9 1.8 Fz.2 sz.6 = 3.4 2s01.9 =2s01.2 zso1.2 zs01.9
£iZe:EE PM 71,2 B8 vz.2 vo.z e.5 738 zE01.9 z=01.9 zs01.9 zE01.9
s:STI0SPM Fl.4 7o Fz.4 5.3 e Fa.1 =s01.9 =s01.2 zs01.2 zs01.9
siSTIIEPM F1.7 4.4 b 7.6 7s.5 3.2 =2s01.9 =2s01.2 zso1.2 zs01.9
8iI7iZEPM 71,5 52,7 73 el 747 T4 zso1.9 zs01.9 zs01.9 zs01.9
£:STIZEPM F1.5 s1.2 Fz.2 s0.6 7.5 3.8 =s01.9 =s01.2 zs01.2 zs01.9
£i3T4EPM F1.9 7.8 7z.2 7.9 5.7 F4.1 2s01.9 2501.2 2s01.2 zs01.9
SDSReporter - Ready -
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Clicking on the “Round this data off to the nearest degree” link will pop up a message box
confirming the action. The rounding only affects imported data. The data in the logged files will
still contain data rounded to one decimal place. Clicking the Yes button will round the data.

Round data to nearest degree? =]

Are vou sure wou wank ko round this data off to the nearest degree?

Moke: This will only modify the imported data, the logged daka files will =till contain data to one decimal place.

Me |

File Menu

File > Save / File > Save As / Save Button =

This will save any changes made to a new or existing report. If an existing file was opened, then
the software will automatically save the file without prompting. If a new file was created, then
the software will display a common Windows Save dialog box that will allow the user to save the
report to the “SDSReports” folder. Once the report has been saved to the “SDSReports” folder,
the software will automatically save the file the next time the save command is chosen.
Clicking the Save As menu option will automatically bring up the Save dialog box.

File > Export
There are four sub-menu options available for the export function:

Export Report to Word

Export Report to RTF

Export Survey Data to CSV

Export to Word - All
The Export Report to Word menu option will export the report to a Word document format,
which will provide more detail than the standard .rtf file format. When this menu option is
clicked, the software will automatically begin to export the report selected to a word document.
Once the report has been exported, the new document will be displayed. ANote - no save dialog
box will be displayed to the user. Initially, the report is saved as “temp.doc” to the “C:\Temp”
directory. The user can rename and save this report to any other desired location. Note - any
time this menu option is used, the resulting report will be saved as “temp.doc”, so any previous
report that has not been re-saved will be lost. The Export Report to R7TF menu option will
export the report to a rich-text format (RTF). When this menu option is clicked, the software
will display a Windows Save dialog box that will save the .rtf file to the “SDSReports” folder. The
Export Survey Data to CSV menu option will export all of the survey data (as seen on the Data
tab) to a comma-separated value format file. When this menu option is clicked, the software
will display a Windows Save dialog box that will save the .csv file to the “SDSReports” folder.
The Export to Word - All menu option will export all of the survey’s information to a Word file
(report data, survey data, eT/C).
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File = Print
This menu option is slightly different from the print button. There are five sub-menu options
available:

Print Report

Print Survey T/C Data

Print Approach T/C Data

Print All

Print Multiple Surveys

The Print Report menu option will allow the user to print out a copy of the .SDSReport file. The
user will have to select the printer to print the report.

T 20|
— Printer
HMame: YhazizvrhLexmark Optra S5 2420 Froperties. .. I
Status: Feady
Type: Lexmark. Optra S 2420
W here: LexmarkPs
Comment: I Print ta file
— Print range Copies
o Al MHumber of copies: |1 E:
£ Fages o i
= || CuCECEE
£ Selection 2 3
ak I Cancel I

The Print Survey T/C Data menu option will print out a copy of the T/C data (as seen on the Data
tab). The user will have the option to configure the page settings and select a printer to print to.
Page Setup

Faper

Size

Source: |.&.utn Select -
Crientation kA arginz [inches]

*  Portrait L =Ft: 0.5 Right: 0.5

" Landscape Top: o5 E ottar: o5

Ok I Cancel | Erinter. . |

The Print Approach T/C Data menu option will allow the user to just print the approach datain a
tabular format. The Print All menu option will print all of the options - Report, Survey T/C Data,
Approach T/C Data - at once. The user will be able to select the printer. All three options will
be printed as separate reports.
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Print Multiple Surveys

The SDS Reporter software will support the ability to print multiple setpoint survey reports.
Note - The software does not support multiple setpoint surveys. The multiple setpoint survey
report screen can be accessed by the File = Print = Print Multiple Surveys menu option. Note
— When the screen is first displayed, the main SDS Reporter screen will be closed and any
unsaved data will be lost. Any unsaved data will need to be saved before printing the multiple
setpoint survey report.

The Print Multiple Setpoint Survey screen will allow the user to select a report template that
utilizes the multiple setpoint survey tags (described below) and up to 5 survey files
(.SDSReport).
The search buttons - [E=lREll: Multiple Setpoint Survey

- next to each

field will allow the Report Template: |C:"-.SSi"'-.SDS"-.Hepu:urtTempIates"-.Sample Report TEI|
user to select the Choose up to 5 surveys

specific report _ _ _

template or survey Survey #1 [C:\S5\SDS\SDSReports\Example Survey SDSR|

file for the report. Survey #2 [C\SS\SDS\SDSRepors\Open Heath 12905.8) .|

Once the ~report Survey #3 [C7\551\5D5\5DSReports\2-2708 SDSReport |
template and survey

files have been Survey #4 C:\S5\SDS\SDSReports'Open Hearth Complete
selected, the user Survey #5 | |
will be able to export —
the report to Word by

clicking on the Export to \lord |
Export to  Word
button.

In order to view the multiple setpoints on a survey, the user will need to use the {n} tag, where n
is the survey number from the Print Multiple Setpoint Survey screen. What the {n} tag does is
tell the report to use the nth survey information for all of the following tags until another {n} tag
is found. Using the displayed screen as an example, the following could be an excerpt from the
template file:
{1} Survey #1 Duration: <SDS:DUR>
{2} Survey #2 Duration: <SDS:DUR>
{3} Survey #3 Duration: <SDS:DUR>

Setpoint: <SDS:SP>

Max T/C Value: #mT/Cv#
{4} Survey #4 Duration: <SDS:DUR>
This survey would display the durations for each of the survey files, and it would also display the
survey setpoint and max T/C value for survey #3. Notice that the normal data tags are still
used. The new tag only tells the software which survey to pull data from. MNote - For single
survey reports, the report template file does not need to be updated. f no {n} tag is used, the
software will default to the first survey file. On the actual report the {1} tag is invisible.
When the Print Multiple Setpoint Survey screen is closed down, the main SDS Reporter screen
will re-open.

Print Button &=
When the user clicks on the Print button, the software will display the print preview screen,
which is similar in design and function to the print preview screen on the View Real-time chart.
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File = Print Preview

There are three sub-menu options available:

Print Preview Report

Print Preview Survey T/C Data

Print Preview Approach T/C Data

Each option will display a print preview of the desired report.

@Print preview

& 2 -| @00 @@ EE @ | Cose |

File > Exit
This menu option will exit the application.

SDS Menu Options

SDS > Manage Survey Templates

The Manage Survey Templates menu option will display the SDS Template Manger screen,
which will allow a user to add new templates and modify existing templates. See the section
SDS Template Manager Screen for a more detailed description of the functions of this screen.

SDS - Download Surveys and Data

The Download Surveys and Data menu option will allow the user to download surveys from a
specific instrument. When the menu option is clicked, the software will begin to search for any
and all dataloggers located on the network.

2 SDSE0XX Data Downloader =13l =]
File oCptions
sSDs: I[1EI2,1BEI,1,21?]SSI tdodel SDS8020 D atalogager SH SDS505000 Vl
Searching for SD'S. .
Finizhed searching. Found 1 SD5.
=1
Dovenload I
-
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Any datalogger found on the network will be added to the drop-down list at the top of the
screen. If no devices are found, a message box will pop up letting the user know that no devices
were found on the network. Check the network connections to verify that any datalogger and
computer is properly connected to the network.

x| Select the instrument from which to download the data files from the

Mo SDS were found... | drop-down list box labeled “SDS:". MNote: Currently, the drop-down list
will also populate with any Video Recorder data loggers as well. Use
caution when selecting the instrument to download data from, since

downloading/deleting data from a Video Recorder using the SDS Reporter software could cause
undesirable consequences. Under the Options menu, the Download menu option will allow the
user to choose to download only data that has been used in surveys, or all of the logged data.
The SDS data logger will log data continuously when it is on regardless if a survey is running or
not. There will be a check mark next to the menu option selected. The default menu option is
Only data used in surveys.

=5 SPSBOXX Data Downloader, =1l Al
File [Esl=ldfalgt]
1 Driovwnload. .. Ld I5 : [192.162.1.211] 551 Model SD52040 Datalogger SH SDSTEERCH
after Downloading... »
S eard Dirive »
Finished sesarcmrig FouRa 3 5ersT

Dovenload |

A

All survey data that is captured on the data logger is transferred to the PC using the SDS
Reporter software and can be reviewed at any time from that PC.

The SDS software will begin to download the survey data once the user has clicked on the
“Download” button. The button will read “Abort” while the data files are downloading. If a
connection to the device cannot be established, the software will display a message box
informing the user.

SDSReporter x|

Zannok establish a connection. Be sure that no other programs are FTRing inkto it.  IF the problem conkinues, try restarting the

survey boo,

If the user chooses to only download | IEEEETITETT =

data files used in surveys, and no data
files are found, the software will display @ Mo survey records were Found.
an error message.
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The software will display a continuous progress of the download status. Note: since there may
be a large number of files to download, this process may take several minutes to complete.

€3 SDSE0XX Data Downloader : iy ] 4

File Options

sDS: I['I 32.168.1.217] 551 Maodel SD53020 D atalogger SM SDS505000

File: datalogi. 347 already exizts locally - skipping.

File: datalog;. 341 already exizts locally - skipping.

File: datalogk. 341 already exizts lozally - skipping.

File: datalogl. 341 alieady exiztz locally - skipping.

File: datalogm. 341 already exists locally - skipping.

Diownloading File: /Elog2006/datalogn. 341 to C:ASSASDSNSDSYSDS505000M 0g20064datalogn. 341 [04,/24/2006 1:00:00
PrA]

Downloading File: /E Alog2006./datalogo. 341 to C:ASSASDSNSDSYSDSE05000M og20064 datalogo. 341 [04,/24,/2006 2:00.00
Phd]

Downloading File: /E Alog2006/datalagp. 341 ta C:AS5ASDSYS D550 S505000M0g20064datalogp. 341 [04./24/2006 3:00:00 _I
PrA]

Downloading File: AEAog2006/datalogg. 341 to C:ASSASDSAWSDSAWSDS505000 0020064 datalong. 347 [04/24/2006 4:00:00 |

okl

| Download I

4

When all of the files have been downloaded, the words “Operation Complete” will be at the
bottom of the list, and the button at the bottom will read “Download”. A message box will also
be displayed reading “Operation Complete”. Clicking on the OK button on the message box will
close down the download data screen.

Clicking on the “Abort” button will stop the download and close the SDS Data Log Extractor
screen. Any files that have already been downloaded will not be erased.

SDS View Real-time Data

The software provides the [Trmmews > (= [ |
ability to view real-time values |[input Value
for each of the thermocouple ||input1 24.08

. - Input 2 24.08 Degree Type: c -
!nputs on the HB1000 serlgs Input 3 4,08
instrument. Generally, this will ||input 4 2478
; Input 5 24.78
be dong to verify that ’Fhe Input 6 5478
connections  are  working |/input 7 2478
roperly. Input 8 24.08
property Input 9 24.08
Input 10 24.08

To open the real-time data
view, click on the SDS menu
and then View Real-time Data;
next, select the HB1000 Series || Messages
instrument for which you want
to see real-time values, and
click OK. The real-time values
will be displayed on screen.
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Options Menu Options

Bedin Survey Options = Show Labels On Chart
This is a toggle switch for the application. When checked, this will display the
“Begin Survey” label for the survey on the real-time graph.

Help Menu Options

Help = Check for Updates

The Check for Updates menu option will check for updates over the Internet and automatically
update the SDS firmware and software. If an update is found, the software will display a
message box asking the user for update confirmation. The software will then automatically
update the files and restart the application.

AutoUpgrade
5S¢ Automatic i ‘

@ Autollpgrade is upgrading local application files,

Downloading AxInterop. CWUIControlsLib. dll

| | Cancel I

If no updates are available, then the software will display a message box informing the user.

Help > About
The About menu option displays the SDS Reporter version that is running, and all of the
previous versions with any version notes.
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About SDSReporter

Application Yerzion: 1.707.0.51
Patch Motes

delete data after it haz been downloaded. S

-Added a test comms option to the S05 menuw. The test comms window will do a broadcast for all 505,
and do a test ping on each of them.  One of three things will ocour:

1] Mo 505 found uszer iz informed no 505 rezponded to the broadcast

21 1 ormore 505 were found, and all succeszsfully rezponded to a ping the user iz informed
that all comms seems akaw.

3 1 ormore 505 were found, and one or more failz to rezpond to a ping for each 505 that
doesnt successfully respond, the uzer will be informed that there wasz a problem testing communications,
and be given the |P address of the 505 which failed ta rezpond. The uger will alzo be informed that the
most common cause iz differing subnets between the 505 and the computer.

-Uzerz should nio longer be able to select a zureey start time that iz earlier then the survey end time [f
they pick the times in the wrong order, the start and stop times will just fip spotz with each other.

Werzion 1.107.0.50

Date: 12/1/06

-Dates and Furnace information added to TC data printout.
-Other zmall bug fixes.

Werzion 1.1071.0.51

Drate: 12/7/08

-Added patch notes to the About dialog.

Cloze

SDS Data Tags
SDS Data tags are created so that all of the template information and survey data can

automatically be used for the report process. Data that is captured during the survey is
summarized to provide the overall results for the report. This can be in the form of a graph,
tabular data, text, eT/C. Data tags have been specifically created to address the uniformity
requirements for AMS and other standards. Tags address, overshoot, minimum T/C with value,
maximum T/C with value, trend data, tabular data, eT/C. An example of an output from the data
tags can be seen by opening the Example report from the SDS Recorder provided with the
installation. The only data not generated from data tags is the tabular print out of the actual
temperatures. This data is generated from the Survey 7/C Data option and will print all data
points that are displayed on the graph between the “start” and “stop” selected by the user in the
survey.

In the figure below (Output From Data Tags), an example of the data tags for the graph, survey
setpoint, minimum and maximum T/Cs with values and deviation is shown. The data tags used
to generate the information below are;

<SDS:GRAPH600x400>
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T/C Survey Summary
Temperature Setpoint: <SDS:SP>°#

Minimum T/C number: #mT/Cn#

Maximum T/C number: #xT/Cn#

Minimum T/C Value: #mT/Cv#

Maximum T/C Value: #xT/Cv#

Min deviation from setpoint:
#md#

Max deviation from setpoint: #xd#

420
#o-
400

3905

TC Trend Data

380 <

370

TC Survey Summary

Minimum TC number: 6

Maximum TC number: 3

Minimum TC Value: 77.8

Maximum TC Value: 418.7

Min deviation from setpoint. -272.2

Max deviation from setpoint: 68.7

Super Systems Inc.

Page 39 of 58



Tag
SDS:FILE

SDS:PD
SDS:PT
SDS:FID
SDS:FM
SDS:FT
SDS:FU
SDS:FD
SDS:FC
SDS:FOR
SDS:SD
SDS:ST
SDS:SDR
SDS:DUR
SDS:0P
SDS:APP
SDS:TITLE
SDS:NOTE
SDS:TOL
SDS:0TS
SDS:SP
SDS:T/CN
SDS:T/CT
SDS:T/CS
SDS:T/CC
SDS:T/CCD
SDS:T/CCF
SDS:SDN
SDS:SDSM
SDS:SDSS
SDS:SDSC
SDS:SDSCD
SDS:SDSCF
SDS:SPEC
SDS:INT
SDS:T
SDS:SIM
SDS:0VS
SDS:MIC
SDS:RES

SDS:GRAPH600x400

SDS:COM
SDS:UDUR
SDS:UT/CN
SDS:PCT
SDS:PDB
SDS:POL

Super Systems Inc.

HB1000 Series Thermal Barrier Operations Manual

Description
The filename the report is saved as

The current date when the report is printed
The current time when the report is printed

The furnace ID

Furnace make/model

Furnace type

Furnace use

Furnace dimensions

Furnace Class

Furnace operating range

Survey date

Survey time

Survey date range

Duration of the survey

Operator. Survey performed by
Survey approved by

The heading, or title, of the report
Notes for the survey

Survey tolerance / uniformity required
Overtemp setpoint

Survey setpoint

Number of thermocouples
Thermocouple type
Thermocouple spool number
Thermocouple calibrated by
Thermocouple calibration date
Thermocouple spool correction factor
Next survey due date

Survey box make/model

Survey box serial number

Survey box calibrated by

Survey box calibration date
Survey box correction factor
Specifications the survey meets
Sample interval

Temperature character - For C
Simulate load, in pounds
Overshoot (Deprecated)

Microns

Survey result

Inserts a 600X400 image of the graph
Company name

User defined survey duration
User defined number of thermocouples
PID cycle time

PID dead band

PID output limit

Usage
<SDS:FILE>

<SDS:PD»>
<SDS:PT>
<SDS:FID>
<SDS:FM>
<SDS:FT»>
<SDS:FU>
<SDS:FD>
<SDS:FC»>
<SDS:FOR>
<SDS:SD>
<SDS:ST»>
<SDS:SDR>
<SDS:DUR>
<SDS:0P>
<SDS:APP>
<SDS:TITLE>
<SDS:NOTE>
<SDS:TOL>
<SDS:0TS»>
<SDS:SP>
<SDS:T/CN>
<SDS:T/CT>
<SDS:T/CS»>
<SDS:T/CC>
<SDS:T/CCD>
<SDS:T/CCF»>
<SDS:SDN>
<SDS:SDSM>
<SDS:SDSS»>
<SDS:SDSC»>
<SDS:SDSCD»>
<SDS:SDSCF»>
<SDS:SPEC»>
<SDS:INT>
<SDS:T>
<SDS:SIM>
<SDS:0VS»>
<SDS:MIC>
<SDS:RES>
<SDS:GRAPH600x400>
<SDS:COM>
<SDS:UDUR>
<SDS:UT/CN>
<SDS:PCT»>
<SDS:PDB>
<SDS:POL>
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SDS:PPB PID PB (gain) <SDS:PPB>
SDS:PR PID rate <SDS:PR>
SDS:PRE PID reset <SDS:PRE>
SDS:CMF Temperature controller manufacturer <SDS:CMF>
SDS:CMA Temperature controller make/model <SDS:CMA>
SDS:IT Controller instrument type <SDS:IT>
SDS:T/CG Thermocouple gauge <SDS:T/CG>
SDS:0V Overshoot - yes or no <5SDS:0V>
SDS:0D Outputs T/C and temp if overshoot occurred<SDS:0D>
SDS:0VT Time the overshoot occurred <SDS:0VT>
SDS:CTD Inserts a note regarding the control <SDS:CTD>

Thermocouple. Inserts nothing if no control
Thermocouple was chosen
SDS:CTN Control thermocouple. Inserts “None” if <SDS:CTN>

None is defined

°# °degree type °#

SDS:ED Survey end date <SDS:ED>
SDS:ET Survey end time <SDS:ET>
SDS:T/CM Thermocouple map (image) <SDS:T/CM>
SDS:UD1 User defined field 1 <SDS:UD1>
SDS:UD2 User defined field 2 <SDS:UD2>
SDS:UD3 User defined field 3 <SDS:UD3>
SDS:UD4 User defined field 4 <SDS:UD4>
SDS:UDb User defined field 5 <SDS:UD5>
SDS:UDé6 User defined field 6 <SDS:UDé6>
SDS:UD7 User defined field 7 <SDS:UD7>
SDS:UD8 User defined field 8 <SDS:UD8>
SDS:UD9 User defined field 9 <SDS:UD9>
SDS:UD10 User defined field 10 <SDS:UD10>
SDS:UD11 User defined field 11 <SDS:UD11>
SDS:UD12 User defined field 12 <SDS:UD12>
SDS:UD13 User defined field 13 <SDS:UD13>
SDS:UD14 User defined field 14 <SDS:UD14>
SDS:UD15 User defined field 15 <SDS:UD15>
SDS:UD16 User defined field 16 <SDS:UD16>
SDS:UD17 User defined field 17 <SDS:UD17>
SDS:UD18 User defined field 18 <SDS:UD18>
SDS:UD19 User defined field 19 <SDS:UD19>
SDS:UD20 User defined field 20 <SDS:UD20>

*** Survey scope data tags - {n} where n is the survey number - are used to display survey
information for the multiple survey report feature. See the section Print Multiple Surveys for
more information on how to use these data tags ***
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Sample Output
Tag
SDS:FILE
SDS:PD
SDS:PT
SDS:FID
SDS:FM
SDS:FT
SDS:FU
SDS:FD
SDS:FC
SDS:FOR
SDS:SD
SDS:ST
SDS:SDR
SDS:DUR
SDS:0P
SDS:APP
SDS:TITLE
SDS:NOTE
SDS:TOL
SDS:0TS
SDS:SP
SDS:T/CN
SDS:T/CT
SDS:T/CS
SDS:T/CC
SDS:T/CCD
SDS:T/CCF
SDS:SDN
SDS:SDSM
SDS:SDSS
SDS:SDSC
SDS:SDSCD
SDS:SDSCF
SDS:SPEC
SDS:INT
SDS:T
SDS:SIM
SDS:0VS
SDS:MIC
SDS:RES

HB1000 Series Thermal Barrier Operations Manual

Sample Output

SDSReport1.sdsreport

2/16/06

11:30:00 AM
BaT/Ch 1
Furnace Mfg.
BaT/Ch Gas Draw
Temper

24 x15x 12

A

650 - 1000°C
2/16/06

11:30:00 AM

2/13 THRU 2/14
00:30:00

Shaun Scott
Scott Brown

Test Survey 1
This is a test survey
[+/-110

+10

750

20

K

Z458

Soandso

1/15/06

-1

2/28/06
SS|1SDS8020
SDS60293201
Super Systems Inc
1/15/06

-1.0

AMS 2750-C and D
10s

F

500

None

N/A

Passed

SDS:GRAPH600x400 [An image of the graph]

SDS:COM
SDS:UDUR
SDS:UT/CN
SDS:PCT
SDS:PDB

Super Systems Inc.

Company Name
30 mins

20

20

2
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SDS:POL 2

SDS:PPB 2

SDS:PR 2

SDS:PRE 2

SDS:CMF Super Systems

SDS:CMA 7EK

SDS:IT B

SDS:T/CG 16

SDS:0V Yes

SDS:0D T/Cé - 1700°

SDS:0VT 5:30

SDS:CTD T/C5 is the control T/C, and is not used in uniformity survey
results

SDS:CTN T/C5

oH# °F

SDS:ED 2/16/06

SDS:ET 11:30:00 AM

SDS:T/CM [Thermocouple imagel

T/C Offsets

Tag Description Usage

#Hol# Offset for T/C1 #ol#

Tag Sample Output

H#ol# -1
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Min/Max/Mean/Spread/Deviation

Tag Description Usage

#n1# Minimum temp for T/C1 within the selected #n1#
Survey region. Substitute numbers for other
T/Cs

#x1# Max temp for T/C1 #x1#

#mi1# Mean temp for T/C1 #mi1#

#s1# Spread for T/C1 #s1#

#vn1# Deviation @min temp from setpoint for T/C1 #vn1#

Hvx1# Deviation @max temp from setpoint for T/C1 Hvx1#

Hvm1# Deviation ([@mean temp from setpoint for Hvm1#
T/C1

#mT/Cn# Minimum T/C number #mT/Cn#

#mtan# Minimum T/C number during approach #mtan#
segment

#mtav# Minimum T/C value during approach segment #mtav#

#mT/Cv# Minimum T/C value #mT/Cv#

#mT/Cx# The maximum temperature of the minimum #mT/Cx#
T/C

#md# Minimum calculated survey T/C absolute #md#
deviation from setpoint

Hrect# Recovery Time - the time between the time Hrect#

when the first T/C comes into tolerance and
the time when the last T/C comes into tolerance

#xT/Cn# Maximum T/C number #xT/Cn#

H#xtan# Maximum T/C number during approach H#xtan#
segment

H#xtav# Maximum T/C value during approach segment Hxtav#

#xT/Cm# Minimum temperature of the maximum T/C #xT/Cm#

#xT/Cv# Maximum T/C value #xT/Cv#

H#xd# Maximum calculated survey T/C absolute #xd#

deviation from setpoint

Super Systems Inc. Page 44 of 58



HB1000 Series Thermal Barrier Operations Manual

Tag Sample Output
#nl# 183
#x1# 183
#m1# 183
#s1# 12.5
#vn1# 383
H#vx1# 383
#vm1# 383
#mT/Cn# 2
#mtan# 2
#mtav# 150
#mT/Cv# 1
H#mT/Cx# 500
#md# 201.0
#rect# 3 mins 30 secs
#xT/Cn# 1
#xtan# 6
H#xtav# 1500
#xT/Cm# 500
#xT/Cv# 183
H#xd# 383.0
H#is# 13.8

Creating a Personalized Template

To create a personalized template, the user needs to open a Word document and save it to the
“ReportTemplates” folder in the main installed folder as a Rich Text Format [.rtf) file. Any of the
SDS data tags listed in the above section can be used to create a company-specific template.
For example, suppose that someone wanted to create a simple template called “NewTemplate”
which displays the current date and time the report is printed, the company name, the title of
the report, the number of thermocouples used, and the results of the survey. First, the user
would open a Word document and save the file as “NewTemplate.rtf” in the "ReportTemplates”
folder in the main installed folder. Next, the user would set up any initial formatting settings,
such as margin sizes, page layout (portrait or landscape), eT/C. Now, the user can set up the
template to his or her company’s specifications. Suppose that the current date and time will be
in the top right corner of the report and should be 10-point Arial font. On the first line, the user
can select the right-justified option, the 10-point font size option, and the Arial font option. This
will leave the cursor in the top right corner. Next, the user will enter the following exactly
(including the brackets]): <SDS:PD>. This will be where the current date is displayed. On the
next line, the user can enter <SDS:PT>. This will be where the current time is displayed. Now
suppose the title of the report should be centered, bold, 14-point Arial font. The user will select
the center-justified option, and the 14-point font size option. This will place the cursor in the
middle of the line. The user will then enter <SDS:TITLE>. The rest of the report - company
name, number of thermocouples used, and the results of the survey - can be left-justified, non-
bold, 12-point font. On the next line, the user will select the left-justified option, the 12-point
font size option, and deselect the bold option. The user can then enter: Company name:
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<SDS:COM>. On the next line the user can enter: Number of thermocouples used: <SDS:T/CN>.
On the next line, the user will enter: Survey results: <SDS:RES>. Next, make sure the document
is saved and close the document out. Note: it is always good practice to save a document in
progress often in case of power failure. The resulting template should resemble the figure
below.

il NewTemplate.rtf - Microsoft Word ==l

JEiIe Edit Wiew Insert Format Tools Table ‘Window Help

== T AR Y = =
EEEEITIEEEY

| raormal ~ | Arial iz B rul=sE=E=sEEEsEO-A-

I

c1

<505 PD=
- <S03 PT=
z <SDS:TITLE>
- Company name: =SDS: COM=
. MNumber of thermocouples used: <SDSTCH=
- Survey results: <SDSRES>

Next, the user will select the report template to use from the SDSReporter application’s Open

option. Clicking on the Open button, —I , next to the Report Template field will allow the user
to choose which report template to use. The user can choose the NewTemplate.rtf file. Next,
the user will choose the “Export to RTF” print menu option on the File menu and choose the
location to save the .rtf file. The actual report should resemble the figure below.

i3l NewTemplateReport.rtf - Microsoft Word & =]
JEiIe Edit Wiew Insert Format Tools Table window Help
JD@H|§@|g|nv|%D|wu% v@’_’JNormal +  Arial - 10 v|B I g|§§§§|§::zg_§§;§|mv&- »
e B & 4 E sen G,

02/21/06

957 A

Test Report - Tim Kell
Company name. SSi
MNumber of thermocouples used: 16
Survey results: Passed
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SDS Template Manager

The purpose of a template is to save the user’s time by filling in some of the more generic
survey data. For example, the user could create a template for one customer, including
company name, T/C type, eT/C; then when the survey is run using this template, this
information is already present and it won't need to be entered for each survey run for that
customer. The new SDS Template Manager allows the user to see any templates saved to a
local computer. The Template Manager also allows the user to create new templates and save
them to a local file on a computer or network.

2 SPS Template Manager
File

Jes| =

<New Template>

Templates
Add Template

| i

Description/Function of Template Manager Screen buttons/menu options
This section will describe the function of the toolbar buttons and menu options for the Template
Manager Screen. Clicking on either the form button or the menu option will produce the same
result, so each pair of button/menu option will be explained in this section.

New Button / File @ New

The New button, —1 , or New menu option will allow the user to create a new set of templates.
The maximum number of templates that can be added per file is 32. Note: initially, there are no
templates in the file.

Open Button / File = Open

The Open button, —j or the Open menu option will allow the user to open an existing template
file from the local computer.
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= Open Template File

* Open a local survey template file located on my computer
Local File

C:ASSMSD5MSurvepT emplatesh T est. tat Browse

(" Open a remote survey template file located on an SO5 instrament

Bemate [SDS)
Select Instrument:

Scan
Cancel Open File |

Click on the Browse button to select the file to open. The SDS software will display a common
Windows dialog box for the user to select which file to open. Once a local or remote file has
been selected, click on the Open File button to open the file, or click on the Cancel button to
close down the screen without opening a file. Note: When the Open Button or the Open menu
option is clicked, the tabs that contain all of the fields for the template will not become visible -
an individual template must be selected to view the tabs. Once the file has been loaded, the
filename will be listed above the Templates list on the left of the form.

Save Buttons / File 2 Save

The Save button, H, or Save menu option will allow the user to save the current file back to the
local machine. Note: Any changes made to any template will be saved at once when this option
is selected. Note: If the user is working with a new template file, the Save function will act like
the Save As function (see below section).

NOTE: The template file can be saved only to the local machine; the file cannot be saved to the
HB1000 Series instrument.

File 2 Save As

This option acts the same way as the Save option, only it will display a dialog box that will allow
the user to select the file to save. This functionality of this screen is similar to the Open
Template screen. The template file can be saved locally on a computer. Click on the Browse
button, which will display a common Windows save dialog box. The user will be able to select
the location and give the template file a name. Click on the Save File button to save the file, or
click on the Cancel button to close down the screen without saving the file.
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18 save Template File As...

@+ Save asurvey template fle on the local computer

Local File

C:ASSMSD 5SS urvewT emplateshTemplates. bt Browsze

" Save a remote survey template file to an 505 instrurnent

Remote [SDS)
Select Instrument:

11.217] 551 Model SDS8020 Datalogger SH 5050807

[192.162.1.216] 55! Model 5 0 Datalogger SM E07119
[192.1621.219] 551 Modsl 5058020 Datalogger SN 5050807116

Scan
Cancel Save File

The software will always display a message box with the success or failure of the save.

Exit Button / File = Exit
This option will close the Template Manager screen.

Add Template Button

This option will add a template to the collection of templates stored in memory, up to 32 total
templates. The only required field is the Template Name. The default template name is
<Template Name>

Once a template has been added, the new template will be loaded into the fields.

Delete Button
This option will delete a template from the collection of 32 templates stored in memory.

Copy Button

This button will copy a template into the collection, assuming there are less than 32 templates
already. This would be useful if the user only wanted to change one or two items on the
template, such as the setpoint.

Arrow Buttons

The arrow buttons next to the Copy button will allow the user to change the order of the
templates in the file. This way, the more commonly used templates can be kept at the top of the
file so the user will not have to scroll down to see the template on the SDS. The up arrow
button will move the template up one position, and the down arrow button will move the
template down one position.
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Description of Template Manager Screen Tabs

Template Information Tab
=2 SDS Template Manager

File
J || d
<New Template>
~Templates
Add Template | M
Default Template Infarmation ] Survey Information ActiveTEs] Controller Information]

Template Name: ]Default

Compary Name: |Super Systems

Furhace |nformation

Fumace ID; |Batch #1 Temp Type: ]F—
. |-350-1000
Make/Model, |Fumacs Mg, Range:

Type: Batch gas draw
e |Batch
Furnace Class: 4l

Dimensiors: |22%12¢10

Motes: lThis iz the default template

fj:
Delete | Copy | J

This tab contains general information about the template such as the Template Name, the
Company Name, furnace information such as the furnace ID, the make and model of the
furnace, the furnace dimensions, the temperature type (Fahrenheit or Celsius), the temperature
range, the furnace type, the furnace use, the furnace class, and any Notes about the template.

See “Description of Template Manager Screen Fields” for the maximum number of characters
allowed per field.
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Survey Information Tab

%= SDS Template Manager
Fil=

MEIE
ASDF.ixt @ C:\SSi\SDS'SurveyTemplates

~Templates

Add Template | M
Template Information  Survey Infarmation ]ActiveTEs] Cantraller Information]
1~ Survey Information
Survey Duration: ’_éﬂ— Minutes Setpoint: 500
Survey Tolerance [+/-]: ]10—‘ A THE.

Simulated Load flbs), 1300 Specification: [aM3 2750 D

i3
Delete | Copy |i1

This tab contains information about the survey such as the survey duration in minutes, the
survey setpoint, the survey tolerance, the operator performing the survey, the simulated load, in
pounds, and the specification the survey meets.
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Active T/Cs Tab

%= SDS Template Manager
Fil=

NEE

ASDF.ixt @ C:\SSi\SDS'SurveyTemplates

~Templates Default
Add Template | LDELEL

Template Information] Survey Information  ActiveTCs ]Eontroller Information]

1~ Thermaocouples

Mumber of TCs: l‘ID— TC Gauge: ’-éE—
TC Type: ]K—
TC Spoal st 1234
TC Spoal Carection: 2

—Active lnputs

IV Usze these active TC settings

vl Input 3 7
vl Irput 4

vl Input 5

Il Input &

vl Input 7

vl Input 8

v lnput 9

2 lput 10 |

| Input 11 v

i3
Delete | Copy |i1

This tab contains information about the active T/Cs such as the number of T/Cs used, the Gauge
of the T/C, the T/C type, spool serial number, spool correction, and a check box for each of the
T/Cs. There is also a check box to allow the user to use the active settings for the T/Cs or to
individually select the T/Cs to. Checking “Use these active T/C settings” will set the checked
T/Cs.
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Controller Information Tab

%= SDS Template Manager

Fil=

NEE

ASDF.ixt @ C:\SSi\SDS'SurveyTemplates

~Templates Default
Add Template | LDELEL

Templatelnformation] Surve_l,llnformation] ActiveTCz  Controller Information

— Terperature Contraller [nformation

Controller Mfg: Cartoller-Mig:
Controller Model:  |R1256
Instrumert Type  |B

—PID Settings

Cycle Time: 10
Dead Band: 2E00

Output Limit: AR0
PE(Gank  [zoo0
Rate: ]TE.DD—
Rieset: W

i3
Delete | Copy |i1

This tab contains information about the controllers such as the Controller Manufacturer, the
Controller Model, and the instrument type. It also contains information about the PID settings
such as the Cycle Time, the Dead Band, the Output Limit, the PB (gain), the Rate, and the Reset.
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Description of Template Manager Screen Fields
This section will describe the Template Manager screen fields and list any constraint for the

fields.

Field Name
Template Name
Company Name
Furnace ID

Furnace Make/Model

Furnace Dimensions
Temp Type

Temperature Range
Furnace Type
Furnace Use
Furnace Class

Notes

Survey Duration
Survey Tolerance
Simulated Load
Setpoint
Operator
Specification
Number of T/Cs
T/C Type

T/C Spool SN
T/C Spool Correction
T/C Gauge

Use Active T/C

Check box 1 -
Check box 40

Controller MFG

Controller Model

Instrument Type

Cycle Time

Dead Band

Output Limit

PB (Gain)

Rate

Reset

General Notes

e Checking “Use these active T/C settings” will enable the checkboxes

Description
The name of the template

The company’s name
The Id of the furnace
The make/model of the furnace

The height, length, and width of the furnace

The type of temperature
(Fahrenheit or Celsius)

The low and high range of the furnace
The type of furnace being surveyed
What the furnace is used for
The class of the furnace
(Version 1.101.0.80 & above)

Any additional notes desired
The duration of the survey in minutes
The survey tolerance/uniformity required
The simulated load in lbs.

The survey setpoint
The operator performing the survey
The specification the survey meets
The total # of T/Cs
The type of T/C
The spool number
The spool correction factor
The gauge of the T/Cs
Use the active T/C settings option
Settings
The active T/Cs for the survey

The controller manufacturer
The controller make/model
The type of the instrument

The PID cycle time
The PID dead band
The PID output limit
The PID PB (gain])
The PID rate
The PID reset

Maximum # of Characters

22
40
17
22
15
1 (F or C)

10
20
15

e Unchecking “Use these active T/C settings” will disable all 40 check boxes. The T/C
check boxes will still be checked, but the SDS instrument will not use these settings.
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Line Diagrams
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Warranty
Limited Warranty for Super Systems Products:

The Limited Warranty applies to new Super Systems Inc. (SSI) products purchased direct from
SSI or from an authorized SSI dealer by the original purchaser for normal use. SSI warrants
that a covered product is free from defects in materials and workmanship, with the exceptions
stated below.

The limited warranty does not cover damage resulting from commercial use, misuse, accident,
modification or alteration to hardware or software, tampering, unsuitable physical or operating
environment beyond product specifications, improper maintenance, or failure caused by a
product for which SSI is not responsible. There is no warranty of uninterrupted or error-free
operation. There is no warranty for loss of data—you must regularly back up the data stored on
your product to a separate storage product. There is no warranty for product with removed or
altered identification labels. SSI DOES NOT PROVIDE ANY OTHER WARRANTIES OF ANY KIND,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. SOME JURISDICTIONS DO
NOT ALLOW THE LIMITATION OF IMPLIED WARRANTIES, SO THIS LIMITATION MAY NOT APPLY
TO YOU. SSl is not responsible for returning to you product which is not covered by this limited
warranty.

If you are having trouble with a product, before seeking limited warranty service, first follow the
troubleshooting procedures that SSI or your authorized SSI dealer provides.

SSI will replace the PRODUCT with a functionally equivalent replacement product,
transportation prepaid after PRODUCT has been returned to SSI for testing and evaluation. SSI
may replace your product with a product that was previously used, repaired and tested to meet
SSI specifications. You receive title to the replaced product at delivery to carrier at SSI shipping
point. You are responsible for importation of the replaced product, if applicable. SSI will not
return the original product to you; therefore, you are responsible for moving data to another
media before returning to SSI, if applicable. Data Recovery is not covered under this warranty
and is not part of the warranty returns process. SSI warrants that the replaced products are
covered for the remainder of the original product warranty or 90 days, whichever is greater.

IMPORTANT!

The Thermal Barrier and Heat Sink must not be used in atmosphere, under vacuum, or for high
pressure quench, unless the product is ordered for that specific application. If the product has
not been ordered for the specific application, damage will occur, and the product warranty will
be voided.
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Revision History

Degree Type added; guideline for
custom Thermal Barrier time and
temperature added; Thermal Barrier
usage guidelines updated; SDS
Reporter menu items updated; manual
format updated.

Rev. Description Date MCO #
NEW | Initial Release 7-6-2012 2103
A Set Off Trigger temp changed; Set 1-21-2015 2156
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